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MacRay

Introduction

MacRay is an interactive application for calculating travel-time curves from two- 
dimensional velocity models. The ability to quickly manipulate velocity models and 
quickly see the resulting travel-times revolutionizes the forward modeling of 
refraction/wide-angle reflection data sets.

MacRay is based upon RAY84 (Luetgert, 1988) and RAY86, seismic raytracing 
programs written for the DEC VAX /VMS environment. Tremendous advantages are 
obtained by exploiting the Apple Macintosh  graphical interface for the display and 
manipulation of velocity models. Typically, the time required to obtain a satisfactory 
velocity model is vastly reduced by comparison to the earlier routines. As an 
additional benefit, the screen graphics produced by MacRay may be directly exported 
to standard Macintosh  drawing applications for the easy production of publication 
quality figures.

Velocity models are defined by two or more interfaces extending across the model 
from left to right. Interfaces may "pinch out" but may not cross. Any pair of 
successive interfaces describe a layer, within which the velocity may be defined in 
terms of the velocity at the top and bottom of the layer. Within any layer the velocity 
may be inhomogeneous, but continuous. First or second order discontinuities in 
velocity may occur at interfaces. The ray tracing algorithm that is used calculates 
the propagation of rays within a layer by the stepwise integration of the system of 
first order differential equations,

<y a(r)= cose-  sine
' Ul AY At

where 6 is the ray's angle from the vertical.

By supplying a definition of V(x,z) and initial values for x, z, t, and 0, subsequent 
values of x, z, t, and 6 may be calculated by simultaneously integrating the above 
three equations over small steps in time. For derivation and details see 
Cerveny el al., (1977).

Lithologic interfaces are represented in the model as first or second order 
velocity discontinuities. When an interface is encountered in the calculation of a 
ray, Snell's law is applied and the calculation is continued.
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Windows

The basic display consists of four windows; a graphics window containing the 
travel-time curves and [optional] picked arrival times ("Travel Time Window"), a 
graphics window containing a plot of the two-dimensional model ("Model Window"), a 
text window containing the ray set results ("Result Window"), and a text window 
containing a log of rayset parameters ("Rayset Log Window").
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MacRay Test
Rel. Rbs. 

Rngle Dist Dist 
56.5274100 53.52 73.52 
56.4433463 59.43 79.43 
56.3592825 65.97 85.97 
56.2752187 71.34 91.34 
56.1911550 76.21 96.21

Time 
9. 11 

10.06 
11. 11 
11.98 
12.78

Red. 
time Code Npnt 
0.19 230 34 
0.15 234 38 
0.11 234 36 
0.09 230 36 
0.08 230 34

Maxbnd
5 
5 
5 
5
5

a
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The Model Window

The velocity model is edited graphically in the Model window using the tools 
displayed at the left side of the window. Select a tool by clicking on it; the 
appropriate cursor will be displayed when the cursor is within the data area. Note 
that when the cursor is within the data area, the ray direction, the current position 
in distance, depth, layer number and velocity are displayed at the bottom of the 
window.

Model
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Editing interfaces:

The model is defined in terms of interfaces (extending from one side of the model 
to the other), layers (corresponding in number to the upper interface, and velocities 
at the top and bottom of each layer at several points along the layer. Each interface 
may be defined at up to 200 points. There may be up to 50 interfaces.

To edit an interface and its corresponding layer, the interface must be selected by 
double-clicking on it (or by using the Interface r Select... command in the Edit 
Menu). Its defining points (nodes) will then be displayed.
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Interface segments and nodes may be moved using the arrow-cursor. Nodes may 
be added, deleted or interpolated using the respective cursors from the toolbox.
Clicking on a node without moving it will select
instead of an open box). Clicking on a selected node will deselect it. By selecting a
series of adjacent nodes, you may define a piece of 
segments which can then be moved as a unit. The 
are selected:

t (it will appear as a filled box

the interface made up of multiple 
following rules govern how nodes

a) Only one contiguous group of nodes may be selected at a time.
b) If there is a gap of unselected nodes between the node you are selecting and 

existing selected nodes, the intervening nodes will also be selected.
c) If you deselect a node from within a string of selected nodes, the smaller 

fragment will- also be deselected.

To select an entire interface, click on one end node, then the other.

If you have difficulty selecting and moving nodes, their size may be increased by 
using the Settings... dialog in the Edit menu.

When moving nodes and interface segments, the program attempts to prevent you
from inadvertently making interfaces cross one another. It will catch 90% of the 
cases, but it is. possible to make interfaces cross if yo!u are not careful. This should be 
avoided.

For precision editing of the model, save it as a TElXT file and use any standard word 
processor to fine tune the parameters.
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Editing velocities:

To manipulate the velocities - Enable the display of the velocity net using the 
Show Net command from the Display menu.

Model

H 10 20 30 40 50 60 70 80 90 100 

D i s lance

> 33.99 8.09 5 6.22

t>

O

Vertical gray lines will appear to represent the velocity net. Velocities are 
defined at the intersections of these net lines and interfaces. At any point in the 
model the velocity and velocity gradient are defined by bilinear interpolation from 
the nearest four velocity definition points. Any layer may have up to 85 velocity net 
lines.

Select a layer for editing by double-clicking on its upper interface (or by using 
the Interface ^ Select... command in the Edit Menu). The velocity net lines for the 
selected layer will appear with little handles at their tops and bottoms. If the layer 
is very thin, the velocity net lines will extend below the layer.
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The velocity net lines may be moved laterally by using click-drag with the mouse 
(careful, they're a little hard to nab). If you have difficulty dragging the velocity 
net lines, you can change the tolerance for determining if the cursor is on the line 
by using the Settings... dialog in the Edit menu.
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To add a new line, hold down the 3  key and click on a line. A new net line will 
appear halfway between this line and the next line to the right.

To remove a velocity net line, hold down both the Option and 
the line.

keys and click on

To edit a velocity net line, hold down the Option key and click on the line. You 
will be presented with the following dialog.

The Next and Previous buttons may be used to step through the velocity net 
lines in the layer. The Set All button sets all of the velocity net lines in this layer to 
the values shown. If you hold down the option key while using the Set All button, 
the speeds at the bottom of the layer are modified \ for each velocity net line. The 
result is that the current vertical gradient is applied to each.
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The Tools.

The tool bar located on the left side of the Model window provides a set of tools for 
manipulating the model. Click on a tool and the appropriate cursor will appear when 
you are within the model axes of the Model Window.

E Arrow cursor - Node points may be grabbed and moved with the arrow 
cursor. Segments of the selected interface may also be moved with the arrow 
cursor. Movement of segments is constrained to the direction of first motion. 
Movement of nodes and segments is constrained to try to keep the interfaces 
from crossing. (This is not always successful). The Arrow cursor is also used 
to change the size of the axes by pulling on the small node at the bottom 
right of the model or travel-time axes.

Insert cursor - Node points may be added to the currently selected interface 
using the insert cursor. Place the cursor at the desired location and click to 
insert a node. Hold down the shift key to temporarily revert to the Arrow 
cursor.

Delete cursor - Node points may be deleted from the currently selected 
interface using the delete cursor. Place the cursor over the node to be 
deleted and click. If multiple nodes are selected, they will all be deleted. Hold 
down the shift key to temporarily revert to the Arrow cursor.

Magnifier cursor - This is used to magnify the display of the model. This is 
useful for fine-tuning the model. The cursor will appear like this: ^4^ . Each
time the cursor is clicked, the model will be enlarged by a factor of two about 
the point clicked. To reverse the zoom, press the shift key. The cursor will
change to appear like this: t\. If you press both the shift and option keys,
model scaling will return directly to 1:1. The Magnifier cursor may be used 
with either the Model window or the Travel Time window.
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Source cursor - This cursor may be used to move the source from its current 
position to any other point in the model. Place the cursor at the desired point 
and click. You may also use the dialog initiated by the 
S our ce r Edit...command in the Commands Menu.

Interpolate cursor - This cursor may be used to interpolate a new node into 
the currently selected interface. Hold down the shift key to temporarily 
revert to the Arrow cursor.
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Changing the axes

The overall size of the axes may be easily changed by dragging the small box at
the lower right corner of the axes.

Ed
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The axis bounds, length, etc. may be changed via a dialog activated by double- 
clicking on axis numbers.

You will be presented with a dialog identifying the axis and allowing you to 
change values using normal editing procedures. Double-click on a number to select 
it, tab to advance to the next value. The Apply button causes the appropriate axis to 
be re-drawn with the currently displayed values. The Revert button returns the 
values and the graph to their original values. The Cancel button does a Revert and 
exits the dialog. The OK button does an Apply and exits the dialog.
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When setting the distance axes for either the Model or Travel Time window, 
holding down the Option key while clicking OK will set the same values for both 
windows.
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If you hold the shift key while double-clicking on an axis, you will get the 
expanded dialog.
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The entry for Tic spacing is also used as the spacing for grid lines if they are 
being plotted (see Show Grid in the Display menu). If the Tic spacing requested 
forces the tic labels to overlap, a larger spacing will be used. The grid will still be 
plotted at the requested spacing, however.
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The Travel Time Window:

The Travel Time Window displays travel time picks and calculated travel times in a 
time vs. distance format.
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The axes parameters may be changed by double-clicking on the axis labels. To 
change the time transformation, see Time Transform... in the Display menu.

The Result Window:

The Result Window displays information about the rays which have been traced.
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Time 
9. 11 

10.06 
11.11 
11.98 
12.78

Red. 
Time 
0. 19 
0. 15 
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0.09 
0.08

Code 
230 
234 
234
230 
230

Npnt 
34 
38 
36 
36 
34

Maxbnd 
5
5 
5 
5
5

e
For each ray, the following information is given:

1) The starting angle in degrees from vertical.

2) The relative lateral distance of the endpoint from the source.

3) The absolute lateral distance of the endpoint in model coordinates.

4) The absolute travel time.

5) The reduced travel time.

1 1
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6) The result code. This number tells how the ray terminated. 

Code Meaning Notes
0

125

126->131

150

175

180

201

202

204

208

230->234

300

The time limit has been exceeded.

The raycode has been violated.

i
Failure to correctly calculate the 
intersection of a ray with an 
interface within the model.

Critical angle failure.

Ray requires more than 400 points.

Ray oscillates about an interface.

Ray left model at left edge.

Ray left model at right edge.

Ray left model at top.

Ray left model at bottom.

Ray ends at a requested interface.

Successful ray guided by Raycode. ,

Increase the Time Limit in the 
Rayset dialog.

This ray is unable to follow the 
layer sequence specified by the 
raycode.

This rarely occurs as the result of 
round-off errors. Try changing the 
Time Step in th& Rayset dialog.

The raycode is attempting to 
calculate a transmitted ray at an 
angle beyond critical. Change your 
starting angles.

Increase the Time Step in the Rayset 
dialog.

Check for peculiarities, e.g. 
waveguides in the velocity model. 
Try changing the Time Step in the 
Rayset dialog.

7) The number of points in the ray.

8) The maximum interface or layer encountered, 
the number of the deepest layer encountered 
negative number, it is the number of the deep

If this is a positive number, it is
as a turning ray. If this is a
est interface for a reflected ray.

12
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The Ray set Log Window:

The Rayset Log Window is used to store rayset parameters. It is essentially a 
scratchpad that can be used to keep track of rayset parameters which work.

Rayset Log
Time: 0.00 60.00 1.0000 0.000100
Source: 0.000 1.001 0
Rayset: 20.0000000 40.0000000 5

B

Using the menu commands in the File menu, you can save the parameters for the 
most recently run rayset. The contents of the window may be edited using standard 
editing techniques. The contents of the window may be saved to a file or loaded from 
a file. You may run the entire contents of the window or, by selecting them, only a 
few lines. A quick way to fine-tune a rayset is to save it in the log window, edit the 
line using copy-and-paste from the result window, select the line and run.

13
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Menus:

w File Edit Commands lilindoui Display

The Apple Menu

The first entry in the Apple Menu is About MacRay... 
display the following message.

Selecting this will

MacRay 1.0
Interactive Two-Dimensional
Seismic Ray tr.icing for the

Macintosh1*1

Written by:
Jim Luetgert
U.S. Geological Survey
345 Middlefield Road
MenloPark,CA 94025
(415)329-4-763

% This is the first release of software which is being
* developed and refined - caveat emptor. Feel free to use 
% and distribute this application, but remember that this,
* too, is intellectual property and attribution is
i appreciated. The proper reference is: Luetgert, J.H.,
* 1992, MacRay - Interactive Two-Dimensional Seismic 
J Ray tracing for the Macintosh , USGS OF 92-356.
* Please send reprints of any published papers using this
* application to the above address.

14



The File Menu

MacRay

D File |
New
Open...
Close
Saue
Saue Rs...
Reuert

Model
Picks
Rayset

Page Setup... 
Print Window... 
Saue Rs PICT... 
Saue Calculated,

Quit

The first group of menu commands pertain to MacRay Project files. MacRay
project files contain information about the velocity model, source locations, and
picks. In addition, MacRay project files contain information about the placement and
size of the graphics windows. They appear on the desktop like this,

MHCtHY

SRPt

New
Open a new untitled model.

Open...
Open a MacRay project file. Standard file dialogs are used. The MacRay project 

file contains information about the velocity model, source locations, and picks. In 
addition, the MacRay project file contains information about the placement and size 
of the graphics windows. Hold the option key down while opening the file to ignore 
this information and use the current windows.

Close
Close the current MacRay project file, 

file, appropriate dialogs are presented.
If changes have been made to the current

15
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Saue
Save the current MacRay project file.

Saue Rs...
Save the current MacRay project file under a new name.

Reuert
Revert to the last saved version of the current MacRay project file.

The next menu command pertains to MacRay Model files. A MacRay Model file is a 
TEXT file describing the interfaces and velocities in the model. It may be edited by 
any standard word processor. A description of the format is at the end of this 
document.

Model >
Hierarchical menu for opening the velocity mocel.

D Model
Open... 
Hose

Saue Rs...

Open...
Open a MacRay model file. Standard file dialogs are used. After a model file is 

opened, the menu will look like this:

Close 
8<n»e 
Saue Rs...

16
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Once the model has been modified, the menu will look like this:

D Model
Open... 
Close 
Saue
Saue fl$... 
Reuert

Close
Close the current MacRay model file. Standard file dialogs are used.

Save
Save the current MacRay model in a TEXT model file.

Save As...
Save the current MacRay model file under a different name or in a different 

format. The following file dialog is used. Normal saves the file in MacRay TEXT 
format. These files may be opened and edited from within any word processing 
application. Ray84 will save the file in Ray84 TEXT format suitable for export to 
Ray84 on any other machine. Ray86 saves the file in Ray86 TEXT format suitable 
for export to Ray86 on any other machine. Seis83, when implemented, will save 
the file in Seis83 TEXT format suitable for export to Seis83 on any other machine.

Figures|

^ hound delete dlog 
hound w**>rt tifog 
hound **MiM:t dlog 
com mantis menu 
depth <we* tiloq

DirectDriu...

Normal QRay84 QRay86 Q Seis83

Revert
Revert to the last saved version of the current MacRay model file.

17
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The next menu command pertains to MacRay pick files. Pick files, containing 
picked arrival times, are assumed to be in TEXT format and are read in free-format. 
The first line must contain a SHOT.RANGE and a REDUCINGJVELOCITY. Additional first 
line variables are TIME.OFFSET to be applied to all times and DISTANCE.MULTIPLIER 
to be applied to all distances. Following the first line are data lines containing a 
TRACE_ID (usually an integer location number or ASCII location name), DISTANCE, 
TIME, [AZIMUTH], and PICK.CODE. DISTANCE is the offset distance, usually km. TIME is 
the picked arrival time. This may be a reduced time, in which case it is changed to 
unreduced time using REDUCING_VELOCITY from the first line. A 
REDUCING.VELOCITY of 0.0 implies that the times are not reduced. AZIMUTH is 
optional and is not used by this application. PICK_CODE is a character code usually 
used for pick-confidence weighting or branch identification. It is not presently used 
by this application. Any line beginning with * is taken as a comment line.

This is an example of a pick file:

121.73
214 100.0000
215 110.0000
216 120.0000
217 130.0000
218 140.0000
219 150.0000
220 120.0000
221 130.0000
222 143.0000
223 167.0000
224 180.0000

8.0
4.1750
4.5500
4.9250
5.3000
5.7500
6.1250
7.2500
7.2500
7.1000
7.5500
7.7000

0.0
126.8000
126.8000
126.8000
126.8000
126.8000
126.8000
126.8000
126.8000
126.8000
126.8000
126.8000

1
1
1
1
1
1
1
1
1
1
1

1.0

Picks >
Hierarchical menu for opening and manipulating files containing travel time 

picks.

D Picks |_____
Open...
Close
Parameters...

Open...
Open a TEXT pick file. Standard file dialogs an; used. When a pick file has been 

opened, its name will appear in the sub-menus for Closed and Parameters.^. 
Up to 10 pick files may be open at once.

18
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Close
D Close"] 

v/m123$1

Close the selected pick file.

Parameters...
D Parameters... |

Change the display parameters of the selected pick file. The following dialog 
allows you to change the X-posiiion of the picks, bias all the times by a constant, 
change the symbol used for the picks, and change the color used for the picks (on 
color machines). You may also turn the display of this pick file on and off.

m123s1 

# of picks: 120
K-position
Tbias (sec):
Symbol

( ) Displayed

Reuert

Cancel

10.000

0.00

mmm

: I: <

® Black
O Green
QBlue

  ORed
*l OVelloui

O Magenta 
QCyan

O

Displayed pick files show a check mark in the Closer and Parameters 
sub-menus.

D Parameters... |
m123s1

19
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The next menu command pertains to MacRay Rayset files. The Rayset Log can be 
used as a scratch pad to create and save scripts of ray sets.

Rayset >
This sub-menu provides a means of maintaining, editing and running a script of 

raysets.

D Rayset |
Open... 
Saue As... 
Run &F 
Enuironment 
Write last 9U

Open... I
Load a previously saved script of raysets into the Rayset Log.

Save As...
Save the current contents of the Rayset Log to a script file.

Run 9$F
Play back the contents of the Rayset Log. You may either play the entire log 

or, by using the cursor to select a subset of lines, j play back a subset of raysets.

Environment
Clicking on this item writes the current raytrace environment to the end of 

the Rayset Log.

| Time: 0.00 60.00 1.0000 
Source: 0.000 0.000 0

0 *

o

o
a

Write last
The specifications for the last set of rays 

Rayset Log.
to be traced are written into the

Rayset Loy
Time: 0.00 60.00 1.0000
Source: 0.000 1.001 0
Rayset: 20.0000000 40.0000000

<>

B

20
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The Rayset Log window contains text which may be edited using standard 
Macintosh techniques. In particular, you may want to insert comment lines to 
help remember the sequence of operations. Any line beginning with * is 
considered a comment and ignored. This also provides a means for temporarily 
removing raysets from a script driven run.

Valid scripting lines contain a keyword and a sequence of variables separated 
by spaces, commas, or tabs (free format). All information must be on a single 
line. There are presently five recognized keywords.

Scripting line Notes

Time: TO TLimit

Source:

Rayset:

Raycode:

Xposition

Angle 1

entry 1

TStep

Zposition

Angle2

entry2

Color

NRays Ray_direction

entryS ... entryN

Clear:

Color is an integer between 0 & 7

The raycode may 
compressed form, 
raycode, give no

be entered 
To turn off 

entries.

in 
the

Erases rays.

21
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Page Setup...
Standard Page setup dialog.

Print LUindoui...
If the model or travel time window is currently active, it will be plotted. If the

result window or Rayset Log window is currently active, it will be printed.

Saue Rs PICT... or Saue Rs TEXT...
If the model or travel time window is currently active, it will be saved in PICT 

format to a file.

If the result or Rayset Log window is currently I active, it will be saved in TEXT 
format to a file.

Saue Calculated...
If rays have been calculated, their times and distances may be saved to a TEXT file 

in pick file format.

Quit
Application will quit after you are given the option of saving your model

22



The Edit Menu

MacRay

D Edit |
Undo

Cut 
Copy 
Paste 
Clear

XH 
*C 
XU

Interface ^ 
Shift Model... 
Model Bounds... 
Settings...

Standard Edit menu items are included for compatibility. These items work when 
editing the raysets in the Rayset Log window. Copy and Paste are also quite useful 
when you are refining the starting and ending angles for a rayset. Copy appropriate 
angles from the result window of your previous run and Paste them into the Rays... 
dialog.

In addition, there are a series of commands which initiate dialog boxes for editing 
the model.

Interface
El Interface)
Select...
fldd...
Delete...

Select...
A dialog box is presented allowing you to select an interface.

Currently selected 
Interface:

23
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Add...
A dialog box is presented allowing you to add an interface to the model.

Insert new interface near
base of layer: QIIHj

Careful. This cannot b

Cancel ] ( 0

B undone!

El

Delete...
A dialog box is presented allowing you to delete an interface from the model.

E IDelete Interface: 

Careful. This cannot be undone!

24
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Shift Model...
A dialog box is presented allowing you to shift the whole model horizontally or 

vertically.

Shift Interfaces up 
Shift Interfaces left

Careful. This cannot be undone!
    a

OK

Model Bounds...
Dialog box is presented allowing you to redefine the limiting bounds of the model.

Left side of model at: 

Right side of model at:

Top of model at: 

Bottom of model at:

100.0

0.0

30.0

km, 

km,

km, 

km,

Careful. This cannot be undone!

The limiting bounds for the left and right sides of the model must fall within the 
defined interfaces. Resetting these values to points beyond the lateral extent of the 
defined interfaces will cause the interfaces to be extended horizontally to the new 
model bounds.

25
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Settings... j
A dialog box is presented allowing you to redefine several miscellaneous 

variables.

Parameters

Node Size 
Picks Size 
Calculated 
Source Size 
Interface Prec. 
Speed Net Prec. 
R-K Precision 0.00010

Reuert) [Default]

Node Size is the size in pixels of the nodes used to manipulate the interfaces. It is 
sometimes easier to do these manipulations if the node size is modestly increased.

Picks Size is the size in pixels of the symbols used to represent picked arrival 
times.

Calculated is the size in pixels of the symbols used to represent calculated arrival 
times.

Source Size is the size in pixels of the symbol used to represent the source.

Interface Prec. is the precision in pixels used to determine whether you have 
touched an interface with the cursor.

Speed Net Prec. is the precision in pixels used to determine whether you have 
touched a speed net line with the cursor.

R-K Precision is the precision variable used by the Runge-Kutta integration 
routine. This is here principally for debugging and | should not be changed.
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The Commands Menu
D Commands |

Source 
Rays... 
Ray Code... 
Calculate
Erase Rays 
Auto Rays 
Shoot Rays < 
Switch SP...

3£R

3SR 
3SE

Source r

This menu allows you to specify the source and produce a list of sources. The 
latter is particularly convenient when you are modeling multiple overlapping shot 
gathers. Once a source list is defined, it may be saved in the MacRay project file 
document along with the model, axis parameters and observed data picks.

D Source |
Edit... 
Update 
Rdd to list 
Remoue from list

SP1

SP3

After a source list has been defined, you may change sources by selecting the 
appropriate source from the menu. Think of this list as a scratchpad. If you select a 
listed source and proceed to Edit... the source definition, you must Update to save 
the new information in the scratchpad.
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Edit...

A dialog box is presented allowing you to redefine the source position and 
name. If you enter a Z-position which is above the model, the source will be 
placed 1 meter within the model when you tab I to the following field. Note that 
you have the option of specifying the source! position in Absolute or Display 
coordinates. Display coordinates are only different from Absolute coordinates if 
you have assigned a Bias value in the Depth or Distance Axis dialogs.

If you are going to save the source in the source list, give it a unique name. On 
machines with color monitors, you may specify different colors for each source. 
The source, rays' and calculated times will be plotted in this color.

Source Oefin tion
Name: SP3

H-position 
Z-position 
Layer

20.000

0.575

1

O Black 
O Green 

Blue

© Rbsolute 
O Display

Eteuert)

8 Yellow 
Magenta 

OCyan

Cancel ] ( OK |

Update

If a listed source is selected, you may update it to the current source 
specifications using this command.

Add to list

The current source specifications are added to 
may contain up to 10 entries.

Remove from list

If a listed source is selected, you may delete it

the source list. The source list

from the list.
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Rays...

A dialog box is presented allowing you to define the current rayset. Angles are 
defined in degrees from the vertical. The number of rays defined here is also used by 
all of the automatic ray-shooting routines defined below.

Rayset Definition

Start flngle
End Rngle 
# of Rays

[20.00

40.00

5

13 Rccept Reflections 
12 Rccept Refractions 
E3 Rccept Others

D Enable Raycode

Raycode Cancel
k .j

| Start Time
Time Step

Time Limit

0.0

1.0

60.0

® Shoot rays right 
O Shoot rays left

[ Reuert ] 1 OK
ji

Start Time is almost always set to 0.0 seconds. The Time Step is initially set to 1.0 
second. This provides a reasonably speedy calculation which is also fairly accurate 
in the absence of tricky velocity gradients. For increased accuracy (at the expense 
of compute time), reduce this value. Making it less than 0.01 is probably meaningless 
for crustal refraction. The Time Limit allows you to place an upper bound in seconds 
on how long the calculation will continue. Rays which terminate within the model 
are usually running up against this limit or the model bounds may be set to lie within 
the defined model.

Radio buttons allow you to specify if the rays are to be shot to the right or the left. 
The direction of rays is displayed in the lower left corner of the Model window. The 
ray direction may also be toggled using the Shoot Rays <-= command in the Command 
menu.

Check boxes specify which of the calculated rays will be plotted.

A button allows you to go directly to the Raycode dialog and a check box allows you 
to enable or disable the Raycode.
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Ray Code...
If a ray code is defined and enabled, rays will follow the defined sequence of 

layers. In this case, the source is in layer 1. Rays traverse layers 1 through 6; are 
reflected at the base of layer 6 and return to the surface. It is a good idea, after 
entering a ray code, to hit the "Verify Ray Code" button to assure that you have a valid 
RayCode.

RayCode Definition

1

2

0

EM

I 2

|l

0

3

0

0

Clear

4

0

0

5 6

0 0

0 0

Uerify

e
C

0

Enable RayCode
Cancel Reuert

5

0

0

4

0

0

Compress

u ....,OK ]

3

0

0

Verifying the RayCode checks that the ray starts 
and makes sure that the layers are all in sequent

in the same layer as the source 
al order. The latter provides a

useful shortcut for entering RayCodes. In the following example, we want to again 
reflect rays from the bottom of layer 6 (this time with a P-S conversion upon 
reflection). We can skip the tedium of entering all the intervening layers and let the 
verifier fill them in.

RayCode

1

0

0

6

0

0

-6

0

0

Clear
A

-1

0

Definition

0

1°

0 0

0 0

0 0

0 0

Uerify [

03 Enable RayCode
Cancel [ Reuert ]

0

0

0

0

0

0

Compress

I    ,OK

0

0

0

i
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This is the RayCode after verification.

RayCode Definition

1

-2

0

2

-1

0
 

3

0

0

Clear

4

0

0

5 6

0 0

0 0

Uerify

-6

0

0

-5

0

0

-4

0

0

Compress

-3

0

0

£3 Enable RayCode
Cancel Reuert i _OK

Calculate
Rays are calculated and plotted using the current rayset settings. Starting and 

ending angles and number of rays are those set in the Rays... dialog. If the RayCode 
is enabled, the RayCode is used. If you need to terminate calculation of a rayset, hold 
the mouse button down.

Erase Rays
All the currently plotted rays and travel-times are erased.
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Ruto Rays ^

This menu allows you to specify the automatic ray functions. Note that some of 
these require that an interface in the model be selected. The number of rays shot 
and the direction from the source are defined in the Rays... dialog above. Each of 
these functions requires that the application find the critical angle for the interface 
of interest. This is accomplished by an iterative search using the starting and 
ending angles from the Rays... dialog as initial values. Sometimes when this search 
fails, changing the starting and ending values to closely bracket the expected critical 
angle will help. There are, of course, some cases where a critical angle cannot be 
found, e.g. low velocity zones, pathologic structuresl

D Auto Rays

Critical flngle 
Rll Crit 
Refract 
Ril Refract 
Reflect 
Rll Reflect 
Rll Rrriuals 
Direct 
PreCrit 
Rll PreCrit

Critical Rngle
The critical angle for the selected interface is found via an iterative search 

using the starting and ending angles from the Rays... dialog as initial values.

Rll Crit
The critical angles for all interfaces are found.

Refract
Rays are calculated and plotted which refract through the layer beneath the 

selected interface.

Rll Refract
All refracted rays are calculated and plotted.

Reflect ft.
Rays are calculated and plotted which reflect post-critically from the selected 

interface.
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Rll Reflect
Rays are calculated and plotted which reflect post-critically from all interfaces.

Rll Rrriuals
A combination of fill Refract and Rll Reflect .

Direct
Rays are calculated and plotted for direct arrivals.

PreCrlt *,
Rays are calculated and plotted which reflect pre-critically from the selected 

interface.

Rll PreCrit
Rays are calculated and plotted which reflect pre-critically from all interfaces.

If you need to terminate an automatic ray calculation before it is completed, hold 
the mouse button down.
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Shoot Rays <= 3CUJ

This menu item allows you to switch the direction in which rays are being shot 
without having to go to the Rays... dialog. The Current ray direction is displayed in 
the lower left side of the Model window.

Switch SP...

This menu item allows you to specify the soui 
displayed via a single dialog. This is redundant 
save motions when. switching back and forth between

to

Select Picks

ce and observed data picks to be 
other menu controls, but should 

sources.

® sp2all 
Osp3all 
® sp4all 
O$p5all

Select Source

OSP1 
SP2
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The Window Menu

The Window Menu allows you to quickly switch between windows, 
particularly useful when the window you want is totally obscured.

This is

The Display Menu

D Window

#2
Edit
T-T
Model
Rayset Log X4

D Display |
Show Net 
Hide Source 
Show Grid

</P uelocity 
S uelocity

Time Transform

Show Net
Click here if you wish to display the velocity net lines on the model, 

item will be replaced by Hide Net when in effect.
This menu

Hide Source
Click here to remove the source from the model plot.

with Show Source.
This menu item will toggle

Show Grid
Click here if you wish to plot a grid overlaid on the plots. Grid lines are plotted at 

the Tic Spacing interval specified in the axes dialogs. This menu item will toggle
with Hide Grid.

4P uelocity 
S uelocity
Click on the velocity function to be used to calculate the travel time plot, 

appropriate menu item will be checked when in effect.
The
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Time Transform...
Click here to open the Time Transform dialog.

Time Transforn

Tmin |KQi Tman 1C

( ) Reduced Time Red. Uel

1

.0

.

O Constant NMO NMO Uel.

O Gradient NMO Surf. Ue 
Gradien 
Base Ue

Reui

Cam

J. 
t
1.

art flpply

:el [[ OK

6.0

6.4

5.3

0.010

6.8

1

You may plot absolute time by specifying Reduced Time with a Reducing 
Velocity of 0.0. If Red. Vel. is greater than 0.0, Tre d != TIME-OFFSET/Red.Vel.
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Files and Icons:

MacRay

This is the application Icon. Click it to run MacRay.

MHCBHV 

SRP1

This is a saved MacRay project document. It contains all the model 
data, picks, sources and window sizing and placement information. 
Click it to run MacRay.

AMod

This is a saved model file. It contains all the model data in TEXT format 
and may be edited using any standard word processor. The data in this 
file is read unformatted, so the placement of fields is unimportant. The 
program recognizes spaces, commas or tabs as field delimiters. Click 
it to run MacRay.

AMod

This is a saved model file. It contains all the model data in TEXT format 
and may be edited using any standard word processor. The data in this 
file is read unformatted, so the placement of fields is unimportant. The 
program recognizes spaces, commas or tabs as field delimiters.

SP1 rays

This is a saved rayset script. It contains all the rayset data in TEXT 
format and may be edited using any standard word processor. The data 
in this file is read unformatted, so the placement of fields is 
unimportant. The program recognizes spaces, commas or tabs as field 
delimiters.

pict

This is a saved graphics file. It contains an image of one of the display 
windows in PICT format and may be edited using any standard draw 
program.

Rays

This is a temporary file used to hold ray graphics information. You 
may find it in your folder if MacRay quits in a non-normal fashion.
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Model File format:

MacRay will read TEXT model files in either 
formats. RAY86 format is preferred and the nati 
superset of the RAY86 format. (Velocities are form 
reference, the following is a specification of the RAY86

RAY84 (Luetgert, 1988) or RAY86 
e output format for MacRay is a 
ted 10f8.3 rather than 10f7.2) For 

format:

First, interfaces are defined. Then velocitiesThe model is specified in two steps, 
at the interfaces are defined.

Interfaces

The model is defined in terms of NBND interfaces each of which must extend from
the left edge of the model to the right edge. The interfaces define NLAY = NBND-1
layers whose velocities are defined in the second pail of the model section. The first 
interface is commonly used to represent surface topography. Interfaces may merge 
but not cross. That is, a layer, defined by two adjacent interfaces, may be made to 
"pinch out". Care must be used in the choice of velocities, however, when pinching 
out layers. It is best to only pinch out layers in regions of constant velocity.

Line 1 - NBND, (NPNT(I), 1=1,NBND) (1415)

NBND = Number of interfaces (50 or fewer).

NPNT(I) = Number of (X,Z) points u£ed to define the Ith interface 
(200 or fewer).

Line 2-N - Interface lines; each interface reads as an ascending sequence of X values, 
possibly requiring multiple lines, followed on a new line by a sequence of 
corresponding Z values under format (10F7.0). Z is defined as positive 
downward. Although the program will work with sea level defined as Z=0 
and elevations above sea level defined as negative numbers, it is ultimately 
less confusing to define an artificially elevated datum such that all 
interfaces are defined with positive values of Z. For final plots of the 
model, the Z-axis may be properly labeled with respect to sea level by 
using the variable ZBIAS. interfaces must extend across the entire model. 
All interfaces should have the same X values at the beginning and end of the 
model.

Groups of interface lines may be separated 
asterisk (*) in the first column to make the

Note: Concerning the interface lines, 
linearly interpolated between the nearest

by comment lines containing an 
N input file easier to read.

if Zj is entered as 999.0, 2\ will be 
defined points.
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Specification of the Velocities

The velocities are specified along vertical grid lines in the model. Where these 
lines intersect the layers, the velocity is specified at the top and bottom interfaces.

This subdivides the model space into a number of polygonal areas each of which 
has a velocity defined at four points. For each of these areas a polynomial "velocity 
surface" is calculated which passes through the defined points. This is a numerically 
neat way of dealing with specifying velocities at any point in the model, but it is the 
source of many problems and frustrations for the user if not properly used.

Remember that the velocity at an interface is explicitly defined only at the 
intersection point with a velocity net line. At all other points along the interface the 
velocity is the intersection of the interface with the velocity surface. In regions of 
the model in which there are large structural or velocity variations, the resultant 
surface may have substantial curvature which leads to unexpected velocities.

The solution to the large curvature problem is to break up the surface into 
smaller surfaces each having smaller curvature through the use of more velocity net 
lines. There is, however, a trade-off here in that the model becomes cumbersome to 
edit if you use more grid lines than you need.

Start off with grid lines at the left and right sides of the model and at those ranges 
where they are needed to define lateral velocity changes. Put additional grid lines in 
any large gaps. If you see rays which do not behave as expected, consider inserting 
additional grid lines.

There are two formats available for specifying velocities. In RAY84 format, the 
vertical grid lines are at the same horizontal distances for each layer of the model. 
This is adequate for simple models. As models become more complex, however, it is 
frequently the case that some layers require many more velocity definition points 
than others. At this point it is useful to use RAY86 format, in which each layer has 
its own vertical grid lines. Format selection is based on the sign of the first variable, 
NXSPD, in line 1.
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Line 1 - NXSPD, NZSPD, VFACTR, GMAX (2|5, 2F10.0)

NXSPD

NZSPD 

VFACTR

GMAX

Number of vertical grid lines (85 or fewer). If this number is 
positive, RAY84 format is used. If this number is negative, 
RAY86 format is used. i

Number of horizontal grid 
variable is ignored by the p

lines (Always use NZSPD=2). 
rogram.

This

A multiplicative factor used for determining S-velocities in the 
model. This is used internally to calculate S-velocities from the 
P-velocity model. If VFACTR = 0.0, it is set to 1.732 . Ray paths 
with mixed S and P paths mist be generated with the ray code.

Maximum vertical velocity gradient in km/sec/km. If your model 
specifies velocities having gradients greater than GMAX, the 
velocity gradient is set to GMAX. If GMAX = 0.0, it is set to 2.0 
by the program.

Line 2 - Model Bounds - DMIN, DMAX, ZMIN, ZMAX (4F7.2)
i

The Model Bounds specify the region in which the model is defined. Normally, 
DMIN and DMAX are equal to the minimum and maximum distances at which 
interfaces are specified. ZMIN should be less than any value of the first 
interface and ZMAX should be greater than or equal to the deepest point of the 
last interface. !

Line 3-N - Velocities

A block of lines for each layer containing velocity data for intersections of the
vertical grid lines with the interfaces.
The first line (15) specifies the number of velocity net lines for the next
layer, NXSPD .
The next line(s) specify the X-coordinates of the velocity net lines.
Velocities at the top and bottom of each layer are read in along interfaces from
left to right (or in the order specified in the previous set of X-coordinates).
First, NXSPD velocities at the top of the layer are read. Then, starting on a
new line, NXSPD velocities at the bottom of the layer are read. For any layer
there are 2*NXSPD values. Layers are taken from top to bottom. All X-
coordinates and velocities are read under format (10F7.2).

Note: If a 0.0 is entered for VEL(I), VEL(I) will be set to VEL(I-1), the 
previous velocity. If a negative number is entered, VEL(I) will be linearly 
interpolated between the nearest defined Velocities.
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Example Model file:

The following is an example model file using the native MacRay format.

9 14 12 11 8 9 4 5 5 2 
* Interface 1

0.000 20.000 30.000 36.810 47.100 64.500 70.000 76.750 88.960 90.002 
101.670 120.000 121.730 140.000

0.574 0. 
0.750 0.

0
121

0
1

0
140

1
1

0
3

0
7

0
10

0
25

0
38

0
45

Interface
.000 20.
.730 140.
.725 0.
.070 1.
Interface
.000 20.
.000
.400 1.
.600
Interface
.000 55.
.000 3.
Interface
.000 40.
.000 6.
Interface
.000 77.
.000 10.
Interface
.000 20.
.000 25.
Interface
.000 50.
.000 38.
Interface
.000 140.
.000 45.

574 
864

000
000
725
100

000

400

500
000

500
500

000
000

556
000

000
000

000
000

0. 
0.

2
47.

0.

3
47.

1.

4
76.
3.

5
54.
3.

6
120.
11.
7
88.
12.
8
95.
38.
9

566 
875

000

850

000

400

500
000

500
800

000
000

889
963

000
000

0 
0

47

1

47

1

99
4

64
3

140
11

120
13

120
35

.491 

.875

.500

.000

.500

.500

.195

.020

.750

.600

.000

.000

.000

.000

.000

.000

0

53

1

64

1

107
4

74
3

140
13

140
35

.635

.500

.000

.750

.500

.000

.000

.000

.600

.000

.000

.000

.000

0.667 0.704 0.751 0.750 0.750

^

54.000 65.000 68.000 76.500 101.672

0.900 0.800 0.900 0.850 0.850

65.000 76.500 76.932 101.449 121.730

1.890 1.890 1.279 1.279 1.600

116.667 122.866 139.775
4.386 5.154 5.848

101.670 106.000 118.700 140. OCO
5.000 5.300 6.610 8.502

Speed Network
-32 2 1. 732 3.000
Model Bounds

0.000

Layer

140.

1

000 0.000 50 .000

32
0

64
.000 20.
.750 65.

000
000

30.
76.

000
000

40
76

.000

.500
47
77

.000

.000
47.500 53.500 54.000 55.500 55.502
77.700 82.000 82.500 91.200 91.702

98.200 98.700 101.670 106.000 107.000 113.200 113.700 118.200 118.700 121.730
122.200 140.000

5.000
5.000
4.500
5.000
5.050
5.050
4.510
5.050

5.000
5.800
5.000
5.000
5.050
5.850
5.050
5.050

5.000
5.800
5.000

5.050
5.850
5.050

5
4
5

5
4
5

.000

.500

.000

.050

.550

.050

5.000
4.500
5.000

5.050
4.550
5.050

4.500
4.500
5.000

4.520
4.550
5.050

4
4
4

4
4
4

.500

.500

.500

.520

.550

.510

5.000
5.000
4.500

5.050
5.050
4.510

5.000
5.000
5.000

5.050
5.050
5.050

5.002
4.502
5.002

5.050
4.510
5.050

41



MacRay

Layer 2
15
0.000 30.000

106.000 107.000
47.000 47.500 54.000 64.750 65.000 76.000 77.700 101.670

118.700 121.730 140.000

5.700
5.700
5.710
5.710

5.700
6.250
5.710
6.255

5.700
6.250
5.710
6.255

5.700
5.400
5.710
5.410

5.700
5.400
5.710
5.410

5.400

5.410

5.400

5.410

5.700

5.710

5.700

5.710

5.701

5.710

* Layer 3
14
0.000 20.000 

107.000 113.200
47.000 47.500 55.500 55.502 64.750

122.200 140.000
76.000 77.700 98.200

5
5
5
5

0

5
5

0

6
6

0

6
6

0

6
7

0

8
8

.900

.900

.917

.910

Layer
9
.000

.917

.960

Layer
9
.000

.200

.250

Layer
9
.000

.250

.360

Layer
7
.000

.800

.000

Layer
5
.000

.000

.100

5.
6.
5.
6.

30.

5.
5.

20.

6.
6.

20.

6.
6.

20.

6.
7.

50.

8.
8.

900
255
917
255

4

000

917
957

5

000

200
250

6

000

250
360

7

000

800
000

8

000

000
100

5.
6.
5.
6.

40.

5.
5.

40.

6.
6.

54.

6.
6.

47.

6.
7.

90.

8.
8.

900
255
917
255

000

917
955

000

200
250

000

250
360

000

800
000

000

000
100

5.
6.
5.
6.

54.

5.
5.

54.

6.
6.

76.

6.
6.

65.

6.
7.

120.

8.
8.

900 5.900 5.900 5.900 5.900 5.900 5.900
000
917 5.917 5.917 5.917 5.917 5.917 5.911
000

000 76.500 98.200 106.000 118.200 140.000

917 5.917 5.917 5.917 5.917 5.917
954 5.940 5.925 5.925 5. 920 5.920

000 76.000 91.702 106.000 121.730 140.000

200 6.200 6.200 6.200 6.200 6.200
250 6.250 6.250 6.250 6.250 6.250

000 91.702 101.670 107.000 1121.730 140.000

250 6.250 6.250 6.250 6.250 6.250
360 6.300 6.300 6.300 6. 300 6.300

000 90.000 118.700 140.000

800 6.800 6.800 6.500
000 7.000 7.000 6.600

000 140.000

000 8.000
100 8.100
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